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1 Welcome to the Tobii Dynavox Compass
Software!

The Compass communication software is a research-based communication solution for individuals who cannot use their natural
voice to fully participate in their everyday lives.

The communication pagesets included in Compass have been created and tested to specifically address the needs and
strengths of individuals with Autism, Cerebral Palsy, Stroke or Traumatic Brain Injury, Apraxia, Down Syndrome, ALS and other
neurological, developmental and communication challenges. A powerful Setup Wizard will guide you through the steps to
choose the pageset that is most appropriate for your user’s age, condition, and ability level.

The Compass software's flexible and intuitive design enables the user to begin with simple, effective communication and ad-
vance at his or her own pace, increasing functionality as his or her skills and comfort level grow.

The Compass software gives you:

● A choice among a number of pagesets that have been designed by clinicians to meet the specific needs of a wide varie-
ty of individuals with differing communication needs and ability levels and using different selection methods.

● The ability to quickly and easily change ability levels within a pageset as your user becomes more proficient at
communication.

● Powerful editing tools to make it easy to personalize your communications solution even further - modify your pages - or
even create new pages!

● Direct access to myTobiiDynavox, a cloud-based website you can use to manage account settings, upload and share
pages, and access clinical, technical, and peer-to-peer support at any time and from anywhere.

● Unique, research-based Core Word Strategy that helps the user develop and use rich and creative communication.
● A full-breadth of pre-stored communication - symbols, pictures, words, and phrases - supporting everyday

conversations.
● Built-in supports such as Behavior Supports and Scripts to help the user successfully navigate through daily activities

and conversations.
● QuickFires and QuickPhrases that allow the user to quickly "jump" into a conversation.
● Easy access to pre-stored messages for many of the user’s favorite activities.
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2 myTobiiDynavox
myTobiiDynavox.com is your personal online storage and administration website that you can use to manage your Compass
software - to back up, update, and personalize Compass and share pages with your entire communication support team.

View help videos, and visit the online library to access Knowledgebase articles, research product tips, and perform custom
searches, or explore the Community Q&A section.

myTobiiDynavox.com is cloud based and available to you from anywhere via the web!

Figure 2.1 myTobiiDynavox

Go to www.myTobiiDynavox.com to register for an account.

Your myTobiiDynavox account integrates you with a community of clinicians, technical experts, and your peers and provides you
with a responsive community of help and support.

After you set up your account, you can access it from anywhere on the web to:

● Upload, download, and share communication pages
● Download voices
● Receive software updates and new communication content
● Manage your user profile
● Backup and restore pagesets
● Access implementation and therapy supports and tools
● View and participate in discussion forums
● Find technical support and documentation resources
● Search the Knowledgebase
● View help videos

Quickly access the Help videos and Knowledgebase on myTobiiDynavox.com through the Help menu in your Com-
pass software. Open the Settings menu, and select Help.
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3 The myTobiiDynavox Knowledgebase
This Compass User's Manual is only a brief, introductory reference to the software. The myTobiiDynavox Community offers a
large and steadily increasing library of over 250 Knowledgebase articles that cover all aspects of the Tobii Dynavox Compass
software.

To illustrate the diversity of articles that can be found in the Knowledgebase, following is a list of a selection of articles:

● Can I Adjust the Number of Rows and Columns Inside a Topic Without Changing Levels?
● Can I add a Core Words button to the Toolbar?
● How to Clear the Message Window After Speaking
● Editing a Topic Collage
● NavBar Pageset - Adding a New Grid Topic
● How Do I Hide Hotspots on a Visual Scene Page?
● How do I Open the Whiteboard from a Button?
● How Do I Edit Quick Phrases?
● How Do I Create a New Phoneme Exception?
● How Do I Add an Action to the Favorites Category?
● How to Link a Button to a Page
● How to Arrange Buttons on a Page or Popup
● How Do I Import a Page or Package of Pages Into a Pageset?
● How to Assign Actions
● How to Change the Onscreen Keyboard
● How Can I Order the Way Buttons are Scanned?
● NavBar Pageset - How to Create a Photo Story

Simply log in to the myTobiiDynavox Community to access the Knowledgebase - and to get answers to your questions, discuss
topics of interest, and join a user group whose interests match yours.
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4 Getting Started
When you open the Compass software, a Pageset Wizard will guide you through selecting the pageset that is most appropriate
for your user’s age, condition, and ability level. (An overview of each pageset is presented below - see 4.2 Compass Pagesets,
page 13.)

4.1 Opening the Compass Software For The First Time
1. Select the Compass icon on your desktop

Figure 4.1 Compass Icon on Desktop

You may be prompted to log into myTobiiDynavox.

The Setup Wizard screen will open.

2. Select the blue Start Setup Wizard button.

Figure 4.2 Setup Wizard Screen

The Pageset Setup screen will open.
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3. Select the Go to New Pageset Wizard button. The Pageset Wizard will step you through selecting, setting up, and
customizing an appropriate pageset.

Figure 4.3 Pageset Setup Screen

The steps involved in the Pageset Wizard will vary depending on your pageset selection.

4. Select an Age, Gender, and Condition from the drop-down menus.

Figure 4.4 New Pageset Wizard

Based on your selections, the Pageset Wizard will present two recommended pageset options.

Select the blue Compare button to see a more detailed description of each pageset recommendation. Select
the View More button to view all available pagesets.
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5. Choose a pageset by selecting its thumbnail on your screen.

Figure 4.5 Select a Pageset

An "about" screen will open providing more specific information on the pageset you have selected.

6. If you decide you want to use this pageset, select the green Select This Pageset button.

Figure 4.6 "About" Pageset Screen

At any point during the setup process, you can select the Back button at the top left corner of the page to go
back and change your selections.

Your pageset will be installed. The length of time it takes to install is dependent on the pageset you chose.

When the pageset has completed installation, the Wizard Questionnaire will open, presenting you with questions specif-
ic to the user:

● Understanding of the use of symbols
● Need for help to communicate
● Desire to communicate
● Ability to understand conversations
● Literacy skills
● Need for page organization
● Answer the questions on the Wizard Questionnaire to the best of your ability.
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Your answers to these questions will enable the wizard to suggest an appropriate communication ability level at which
your user should begin.

IMPORTANT! Remember, you can easily change levels at any time - move up as the user becomes more proficient at
communicating - move down if the user seems challenged. Select Levels in the Settings menu to quickly move be-
tween levels.

The Customize Content screen will open. The customization options on this screen will vary depending on the page-
set you have selected. Below, as examples of the different options on each pageset, we show the Customize Content
screens for the All Access, Master Page, and NavBar pagesets.

7. Continue to customize your content, making a selection from the choices presented, and then selecting the green Next
button at the bottom right of the screen to open the next tab on the Customize Content screens.

Figure 4.7 Customize Content Screen - All Access Pageset

Figure 4.8 Customize Content Screen - Master Page Pageset
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Figure 4.9 Customize Content Screen - NavBar Pageset

The All Access and Navigator pagesets allow you to choose an access method during the customization
process.

When setup is complete, a Congratulations! screen will open.

8. From the Congratulations screen, you can:

● View orientation videos. (The Orientation tab will, by default, be open. Select the play button to launch the orienta-
tion videos.)

● Select the myTobiiDynavox tab for information on the myTobiiDynavox.com website. (See 2 myTobiiDynavox,
page 7.)

● Select the Resources tab for a list of resources available on the myTobiiDynavox.com website to support your use
of the Compass software.

Figure 4.10 Congratulations Screen

When you have viewed the videos and learned about the myTobiiDynavox.com website, select the Start Commu-
nicating button. You are now ready to start communicating using your Compass software!

It is important to back up your pageset on a regular basis. See 18 Backing Up and Restoring, page 82.

4.2 Compass Pagesets
The Compass software offers a variety of pagesets to provide the best fit for your user’s unique strengths and needs.
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4.2.1 NavBar Pageset

This pageset is available in English only.

The NavBar pageset offers access to communication topics on a scrolling Navigation Bar (NavBar) and additional tools on a
static Toolbar. Both the NavBar and Toolbar are always visible and always accessible. The user does not have to go to a “home
page” to switch between communication topics - simply swipe through a customized list of topics. The NavBar pageset utilizes
either a visual scene layout with hotspots or a more traditional grid layout. Content in the NavBar Pageset is adjusted based on
ability level. The NavBar pageset provides each communicator with a host of integrated communication tools, all of which can
be customized for all ages and ability levels.

The NavBar pageset is recommended for children and adults, individuals who have good visual organization skills and would
benefit from having access to their communication topics at all times, and individuals who are able to access a dedicated com-
munication device or personal tablet computer with their finger or stylus and who do not need a keyguard.

4.2.2 Master Page Pagesets

This pageset is available in English only.
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The Master Page pagesets feature a traditional “master" or "main” page with links to topics and communication tools. The Mas-
ter Page pagesets can utilize either visual scenes or a grid layout. These pagesets are of a similar design and organization as
compared to previous Tobii Dynavox devices. The Master Page pagesets can be customized for all ages and ability levels and
are appropriate for keyguard users.

The Master Page pagesets are recommended for children and adults, individuals who have had success with more traditional
"grid" based organization and would benefit from having their communication topics organized around a "master page," and in-
dividuals who need a keyguard to improve accuracy with direct selections. Alternative access methods such as scanning are al-
so available.

4.2.3 Text-based Pageset

This pageset is available in English only.

The Text-based pageset offers communication pages with single words and complete messages organized as Topics, Quick-
Fires, Keyboards, and other communication tools. The Text-based pageset is designed for literate teenagers and adults, individ-
uals who have minimal to no difficulty reading from an array of pre-programmed words and phrases, and individuals who need a
keyguard to improve accuracy with direct selections. Alternative access methods such as scanning are also available.
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4.2.4 Stroke & Brain Injury Persona Pageset

This pageset is available in English only.

The Stroke & Brain Injury Persona pageset is the first comprehensive communication pageset designed to address the unique
language needs of individuals with aphasia. Designed through extensive research, field-testing, and customer insight, it provides
an unmatched solution for those who have had a stroke, brain injury, or other condition resulting in aphasia or other language im-
pairment. The Stroke & Brain Injury Persona pageset provides access to a scrolling navigation bar and additional tools on a stat-
ic Toolbar. Both are always visible and always accessible. The user needn't go to a “home page” to switch between
communication topics. Simply swipe through a customized list of topics. The Stroke & Brain Injury Persona provides each com-
municator with a host of integrated communication tools.

The Stroke and Brain Injury Persona pageset is recommended for adults, individuals who have communication challenges (e.g.,
aphasia) as a result of stroke or traumatic brain injury, and individuals who are able to access a dedicated communication device
or personal tablet computer with their finger or stylus, and who do not need a keyguard.
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4.2.5 WordPower Pageset

This pageset is available in English only.

WordPower is a popular core word strategy pageset combining the features of core vocabulary, spelling, and word prediction
to create novel messages. Developed by Nancy Inman, MS, CCC-SLP as an alternative to traditional keyboards, it is recom-
mended for children through adults with a wide range of ability levels. The WordPower pageset is recommended for children
and adults who can benefit from core vocabulary and/or spelling with word prediction. Multiple alternative access methods are
available. Communication displays are text based and available with or without symbol support. Individuals with a wide range of
communication abilities have utilized this pageset. Access is available with a keyguard or through direct selection or alternative
access including scanning.

4.2.6 All Access Pageset

This pageset is available in English, Dutch, Danish, Norwegian, Spanish, and Swedish.

The All Access pageset is primarily designed to support the communicative needs of individuals who use scanning, a head
mouse, or other alternatives to touching the screen with a finger. This one-of-a-kind pageset includes a comprehensive vocabu-
lary that can be separately adjusted based on communicative ability and the number of buttons available at one time. In addition,
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the All Access pageset allows individuals to move quickly from page to page, access the device volume and other controls, and
completely change settings and layouts by selecting one button. Other innovative features support easy storage of messages
on a page, efficient retrieval and editing of messages previously spoken, and a wizard to walk individuals through selecting an
access method. While not the primary audience, individuals who can successfully touch the buttons on the screen may also find
the organization of the All Access pageset useful.

4.2.7 Navigator Pageset

This pageset is available in English, Dutch, Danish, Norwegian, Spanish, and Swedish.

The Navigator pageset is designed to support the needs of individuals who are literate and primarily want to use a keyboard to
communicate. To support efficient and effective communication, however, the Navigator pageset provides a structure to store
topic-specific messages, efficiently access and edit previously spoken messages, and communicate pre-programmed phrases
that can be used in a variety of settings. The pageset uses a series of levels to introduce new communication tools and other
features in a way that promotes easier learning and more successful use. The Navigator pageset can be accessed in a wide va-
riety of ways, including touching the screen, scanning, and using a head mouse.
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4.2.8 LiterAACy Pageset

This pageset is available in German only.

LiterAACy takes a different approach to learning how to read and write. LiterAACy categorizes words by their first letter, so that
users with knowledge of the initial sound of a word can access it quickly. On average, a user can access up to 3,000 words by
just two selections. These quick wins motivate the student to further develop their reading and writing skills. Using clear sym-
bols, color coding according to the Fitzgerald key, deliberate hiding of letters, and speech output all facilitates the advance-
ments of reading and writing skills even further.

4.2.9 Premium Pagesets

In addition to the pagesets offered with the Compass software, premium pagesets are also available - the Gateway and PODD
pagesets.

4.2.9.1 Gateway Pageset

This pageset is available in English and German.
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Created by Dr. Joan Bruno, Ph.D., CCC-SLP, Gateway is comprised of single words that can be joined together to create lon-
ger messages. Gateway has evolved over the years to reflect a variety of developmental levels, types of communicators, and
changes in technology.

4.2.9.2 PODD Pageset

This pageset is available in English only.

PODD, created by speech pathologist Gayle Porter, is a way of organizing whole word and symbol vocabulary to provide im-
mersion and modeling as well as a means to express a range of messages in a variety of environments. There are PODD page-
sets to provide multiple options to suit the communication and language requirements of different individuals.

The PODD pageset is available in both U.S. English and Australian English versions.

For more information on these premium pagesets, including pricing and ordering information, visit myTobiiDynavox.com.
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5 The Settings Menu - Overview
The Compass software is easily customizable and includes powerful editing tools. Customization options and page editing and
page creation tools are accessed through the Settings menu.

The Settings menu gives the user access to the Page Browser, Editor, Page Creator, Vocabulary, Interface and Toolbar set-
tings, Voice Settings, Rate Enhancement components, ability level settings, the camera and media library, the Remote Manager,
access method settings, and backup and restore functions, as well as links to help documentation and videos.

Figure 5.1 Settings Menu

The table below provides an overview of the options available on the Settings menu. Detailed information on each of these op-
tions is provided as noted.

Table 5.1 The Settings Menu

Page Browser Quickly opens a page in your pageset. Search for a specific page by name, manage your pa-
ges, create, delete, and navigate through the layers of folders and see preview images of pages
before opening them. (See 10 Page Browser, page 58.)

Editor Opens the Editing Toolbar, which enables you to edit (and create) pages. (See 12 The Com-
pass Editor, page 65.)

Page Creator Create an entirely new page - either from a template or based on the layout of an existing page.
After you select a template or layout, the Editing Toolbar will open, and you can customize your
new page with your own content. (See 13 Creating a Page, page 73.)

Vocabulary Your vocabulary (your talk topic choices, word lists, and phrases) was selected when you used
the Setup Wizard to select a pageset and is based on your input regarding your age, gender,
condition, and communication level. You can edit, copy, delete, change the order of appear-
ance onscreen, and add new vocabulary items. (See 8 Vocabulary , page 53.)

Interface Adjust or define how certain objects are presented onscreen. The Interface menu is organized
by tab, with each tab pane presenting a different group of controls and options, including gen-
eral settings, message window settings, button settings, and age and ability level settings.
(See 6.3 Interface Settings, page 42.)

Access Method Select and customize a selection method. (See 6.1 Access Method, page 24.)

Toolbar Editor Personalize the Toolbar - add a new button or folder, edit or delete buttons or folders, hide, or
rearrange Toolbar items. (See 6.4 Toolbar Editor, page 44.)
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Voice Settings Select and customize a speaking voice for the Compass software, download new voices, and
manage pronunciation exceptions. (See 6.2 Voice Settings, page 38.)

Rate Enhancement Compile a personalized list of abbreviation expansions and activate or deactivate word predica-
tion features, and select message history options. (See 7.1 Abbreviation Expansions, page 47,
7.2 Word Prediction, page 49, and 7.3 Message History, page 50.)

Camera On devices with an integrated camera, snap images that are saved to the media library. (The
Camera menu will be grayed out if the device does not have an integrated camera.) (See 16
Camera, page 80.)

Media Library Use the Media Library to store and view your photos and videos. (See 17 Your Media Library,
page 81.)

Backup/Restore Create a backup file that saves your customized settings. Restore the backup files you created.
Backup and restore either locally or to/from myTobiiDynavox.com. (See 18 Backing Up and
Restoring, page 82.)

Help Opens the Help menu with links to access documentation, help videos, and the
Knowledgebase.

Levels Depending on the pageset you are using, a Levels button (ability level settings) may be present
on the Settings menu. Quickly change the ability level to find the most appropriate tools and
content and grid size to fit your user’s current needs. (See 9 Ability Levels, page 56.)

Remote Manager The Compass software has the capability on selected devices of remotely controlling electronic
equipment. (See 14 The Remotes Manager, page 74.)

When running on open Windows devices, there is an additional option on the Settings menu - Exit . This
closes the Compass software and returns you to the desktop.

5.1 Open the Settings Menu
There are two methods of opening the Settings menu, depending on whether or not the Toolbar is visible onscreen

5.1.1 Open the Settings Menu if the Toolbar is Visible

Simply select the Settings button on the Toolbar. The Settings menu will open.

5.1.2 Open the Settings Menu if the Toolbar is Not Visible

1. Select the Modify button in the top right corner of your screen.

Figure 5.2 Modify Button

On the All Access and Navigator pagesets, the Modify button is located at the bottom right corner of the

screen.

A dialog will open presenting you with two options
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2. Select the Settings button. The Settings menu will open.

When the Toolbar is enabled, the Settings button will always be visible on your screen. For instructions on en-
abling the Toolbar, see 6.4 Toolbar Editor, page 44.
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6 Customizing the Compass Software
6.1 Access Method
The Compass software allows you to choose and refine a selection method that best suits your user’s needs.

If you are using the Navigator or All Access pagesets, you will have chosen your access method during initial setup
when customizing your pageset.

To watch a video that explains the various access methods in detail, go to myTobiiDynavox.com and select the video
“Making Selections” (Access Methods). (This video can be quickly accessed through the Help menu.
[Settings > Help > Help Videos.])

Open the Settings menu. (See 5.1 Open the Settings Menu, page 22). Then select Access Method.

Figure 6.1 Access Method Settings

Simply select the access method that you would like to use.

Simple Touch is the default access method.

The Gaze Interaction access method is available only on Tobii Dynavox I-Series devices.

When you make a selection on the Access Method menu, a Settings button will appear (circled in Figure 6.1 Access Method
Settings, page 24). Select the Settings button to open a menu that will enable you to customize the settings for your selection
method.
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6.1.1 Simple Touch Settings

Figure 6.2 Simple Touch Settings Menu

For simple touch, select the check box to enable swiping, and choose from the scrollbar visibility options. Select an audio cue.
(See 6.1.8 Audio Cue, page 37.)

6.1.2 Touch Enter Settings

Figure 6.3 Touch Enter Settings Menu

For the touch enter access method, select a hold time and release time, and choose from scrollbar visibility options. Select an
audio cue. (See 6.1.8 Audio Cue, page 37.)

Tobii Dynavox Compass User’s manual v.2.3 - en-US 6 Customizing the Compass Software 25



6.1.3 Touch Exit Settings

Figure 6.4 Touch Exit Settings Menu

For the touch exit access method, select a hold time and release time, and choose from scrollbar visibility options. Select a high-
light style and color (see 6.1.7 Highlight Style and Color, page 37) and an audio cue. (See 6.1.8 Audio Cue, page 37.)

6.1.4 Scanning Settings

6.1.4.1 Scanning Settings - Scan Type

Figure 6.5 Scanning Settings Menu

Select a scan type, 1 switch autoscan or 2 switch step scan
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6.1.4.1.1 1 Switch Autoscan

1. Select the blue Settings button under 1 Switch Autoscan. A dialog will open enabling you to select a scan speed.
(Use the up and down arrows to adjust the speed.)

Figure 6.6 Select a Scan Speed

2. Select the Trans. Time tab. A dialog will open enabling you to set the transition time (the pause time between levels in
the scan pattern). (Use the up and down arrows to adjust the time.)

Figure 6.7 Select a Transition Time

3. Select the Scan After tab to enable or disable scanning options.

Figure 6.8 Scan After Dialog

4. Select OK on the Scan After dialog to return to the Scanning Settings menu.
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5. On the Scanning Settings menu, select a switch input to signal the software to advance the scan highlight.

Figure 6.9 Select a Switch Input For 1 Switch Autoscan

6.1.4.1.2 Switch Step Scan

1. Select 2 Switch Step Scan on the Scanning Settings menu.

Figure 6.10 Select a Switch Input For 2 Switch Step Scan

2. Select the Switch 1 Input drop-down list to choose the keyboard key that will provide a switch input to signal the soft-
ware to advance the scan highlight.

3. Select the Switch 2 Input drop-down list to choose the keyboard key that will provide a switch input to signal the soft-
ware to make a selection.

The default switch inputs are the left arrow for switch 1 and the right arrow for switch 2.
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6.1.4.2 Scanning Settings - Scan Pattern

1. Select the Pattern tab on the Scanning Settings menu.

Figure 6.11 Scanning Settings - Pattern Tab

2. Select a scan pattern (row/column, column/row, or linear).
3. Select the number of passes. The software can be set to scan infinitely or to stop scanning if no selection has been

made after the page has been scanned a set number of times.
4. To restart scanning where a selection was made, select the Enabled check box next to Scan from Last Selection.

6.1.4.3 Scanning Settings - Interface

1. Select the Interface tab on the Scanning Settings menu.

Figure 6.12 Scanning Settings - Interface Tab

2. Select the Enabled check box next to Enable Back if you want the scan highlight to return to the previous level after a
selection has been made.

3. Select the Enabled check box next to Enable Reset if you want the scan highlight to reinitialize after a selection has
been made.

4. Select the Enabled check box next to Scan Back/Reset First if you want to move the scan icon to the beginning of
the scan pattern.

5. To automatically increase the size of each object as it is scanned, select the Enabled check box next to Zoom.
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6. Select a highlight style and color. (See 6.1.7 Highlight Style and Color, page 37.)
7. Make a selection next to Scrollbar Visibility.

6.1.4.4 Scanning Settings - Pages

1. Select the Pages tab on the Scanning Settings menu.

Figure 6.13 Scanning Settings - Pages Tab

2. Next to Scan Toolbar, make a selection as to how you want the Toolbar to scan.
3. Select the appropriate Enabled check box:

● To include the Modify button in the scan pattern.
● To include the message window in the scan pattern.
● To include blank buttons in the scan pattern.

6.1.4.5 Scanning Settings - Audio Cue

Select the Audio Cue tab on the Scanning Settings menu. For information on audio cue settings, see 6.1.8 Audio Cue, page
37.
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6.1.4.6 Scanning Settings — Hold Time

1. Select the Hold Time tab on the Scanning Settings menu.

Figure 6.14 Scanning Settings — Hold Time tab

2. Set the hold time using the arrow buttons.

Figure 6.15 Scanning Settings — Hold Time
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3. Check the box beside “Enable visual cue while holding switch” to see an animation illustrating the required hold time
when the switch is activated.

Figure 6.16 Scanning Settings — Enable Visual Cue

Figure 6.17 Scanning Settings — Scanning Hold Time Visual Cue

6.1.5 Gaze Interaction Settings

Gaze Interaction is available only on Tobii Dynavox I-Series devices.

Figure 6.18 Gaze Interaction Settings Menu
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6.1.5.1 Gaze Interaction Settings - View Track Status

Opens the Track Status viewer where you can verify that the Gaze Interaction software recognizes the user’s eyes and that
the user is well positioned in front of the device.

Figure 6.19 Track Status Viewer

The two dots that represent the user’s eyes should be in the middle of the viewer. The white triangle in the distance meter on
the right side of the viewer should be near the center, in the green, when the optimal distance from the device is reached.

6.1.5.2 Gaze Interaction Settings - Start a New Calibration

Opens a screen that begins the calibration process. The software will automatically calibrate the user’s gaze as he or she fol-
lows the targets onscreen. When calibration is completed, a dialog will open with the results of the calibration.

6.1.5.3 Gaze Interaction Settings - Pause Eye Tracking

When this feature is enabled, a Pause icon appears onscreen - the user can temporarily stop gaze interaction to rest his or her
eyes.

Users can also add their own pause and resume eye tracking buttons to pages by using the actions PauseEyeTrack-
ing() and ResumeEyeTracking().

6.1.5.4 Gaze Interaction Settings - Activation Settings

Select an activation method:

● Dwell Settings
Dwell activation allows the user to select by directing their gaze consistently on an object for a set amount of time (dwell
time).

Select Dwell, then select the Settings button under Dwell. The Dwell Settings dialog will open. Select a dwell time.

● Switch Settings
Switch activation allows the user to select by pressing an accessory switch or keyboard key.

Select Switch, then select the Settings button under Switch. A dialog will open.

– Select an activation time. Then select OK.
– Select the Wait Time tab, and select the time between switches. Then select OK.
– Select the Switch tab, and select a switch input. (If you are not using the switch ports on the device.) Then select

OK.

● Blink Settings
Blink activation allows the user to select by blinking their eyes for a set amount of time (blink time).

Select Blink, then select the Settings button under Blink. A dialog will open.

– Select a minimum blink time. Then select OK.
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– Select the Max. Time tab, then select a maximum blink time. Then select OK.

6.1.5.5 Gaze Interaction Settings - Feedback

Select the Feedback tab on the Gaze Interaction Settings menu. Select a color, size, and type of feedback target to be
used during use.

Figure 6.20 Gaze Interaction Settings Menu - Feedback Tab

6.1.5.6 Gaze Interaction Settings - Windows Control

Select the Windows Control tab on the Gaze Interaction Settings menu to set the mode of desktop access.

Figure 6.21 Gaze Interaction Settings Menu - Windows Control Tab

6.1.5.6.1 Gaze Selection

Gaze selection mode of Windows control makes it possible for the user to control a standard Windows desktop operating sys-
tem with a two-step selection method, which reduces the risk of unwanted clicks.

6.1.5.6.2 Mouse Emulation

The mouse emulation mode makes it possible for the user to emulate and control a standard PC mouse pointer on the screen.

34 6 Customizing the Compass Software Tobii Dynavox Compass User’s manual v.2.3 - en-US



6.1.5.7 Gaze Interaction Settings - Gaze Interaction Profile

Select the Gaze Interaction Profile tab on the Gaze Interaction Settings menu.

Figure 6.22 Gaze Interaction Settings Menu - Gaze Interaction Profile Tab

The Gaze Interaction profile tab is used to switch between different Gaze Interaction profiles. Profiles can be created using
the Gaze Interaction Settings program on your desktop.

6.1.5.8 Gaze Interaction Settings - Audio Cue

Select the Audio Cue tab on the Gaze Interaction Settings menu. For information on audio cue settings, see 6.1.8 Audio
Cue, page 37.

6.1.6 Mouse Settings

Figure 6.23 Mouse Settings Menu

6.1.6.1 Mouse Settings - Select With

6.1.6.1.1 Dwell

Dwell activation allows the user to select by placing the cursor over an object for a set amount of time (dwell time).

1. Select Dwell.
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2. Select the blue Settings button under Dwell. A dialog will open enabling you to select a dwell time. (Use the up and
down arrows to adjust the time.)

Figure 6.24 Dwell Time Settings

6.1.6.1.2 Switch

Switch activation allows the user to select by pressing an accessory switch or keyboard key.

1. Select Switch.
2. Select the blue Settings button under Switch.

Figure 6.25 Switch Settings - Switch Input

3. Select a switch input.
4. Select OK.

6.1.6.2 Mouse Settings - Scrollbar Visibility

Choose from scrollbar visibility options.

6.1.6.3 Mouse Settings - Highlight Style and Color

Choose a highlight style and color. (See 6.1.7 Highlight Style and Color, page 37.)

6.1.6.4 Mouse Settings - Audio Cue

Select the Audio Cue tab on the Mouse Settings menu. For information on audio cue settings, see 6.1.8 Audio Cue, page
37.
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6.1.7 Highlight Style and Color

Figure 6.26 Highlight Style and Color in Mouse Settings Menu

1. Use the Highlight Style drop-down list to select how selected objects will visually stand out on the page.

Highlight styles

1. No Highlight

2. Outline

3. Invert

4. Overlay

2. Select the Color button (circled in Figure 6.26 Highlight Style and Color in Mouse Settings Menu, page 37). The Color
Selector dialog will open. Select a highlight color. (You can also create a custom color using the Color Selector
dialog.)

6.1.8 Audio Cue

An audio cue is a single word or short message that is played to identify an object when the cursor (or scanning highlight)
moves over the object. You can select a different voice to speak audio cues than the voice you use for regular communication.
You can enable or disable audio cues, choose the volume and speech rate for the voice you’ve chosen, and boost the sound
level.
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An Audio Cue tab is available on the Settings menus for all the access methods.

Figure 6.27 Audio Cue Tab on Simple Touch Settings Menu

On some devices, you will have the option to choose between private or public output for the audio cue.

The audio cue defaults to the object’s label.

1. Select the check box next to Usage to enable audio cues.
2. Select a voice for audio cues from the Voice drop-down list.

For information on downloading voices from myTobiiDynavox.com, see 6.2 Voice Settings, page 38.

3. Select the check box next to Voice Boost to enable the volume boosting feature.

If you notice the speech is "breaking up," disable the Voice Boost feature.

4. Use the Volume slider to set the volume from 0 to 100.
5. Use the Rate slider to adjust the speaking rate. Dragging the slider from left to right increases the speech rate.

Select the Speak button to the right of Voice Preview to hear how the voice and rate of speech you have selected
sounds. You can change the voice and increase or decrease the rate of speech until you are happy with the voice and
the speaking rate you have chosen.

The default text in the Voice Preview text box is, "This is how the voice currently sounds." To change the text
in the text box, select it and enter your own personalized message.

6.2 Voice Settings
You can select and customize a speaking voice for the Compass software as well as manage pronunciation exceptions for fre-
quently used words.

You can select a different speaking voice for audio cues. (See 6.1.8 Audio Cue, page 37.)
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Open the Settings menu. (See 5.1 Open the Settings Menu, page 22.) Then select Voice Settings.

Figure 6.28 Voice Settings

6.2.1 Voice

Select a speaking voice from the Voice drop-down list.

6.2.2 Download & Manage Voices

Select the Download & Manage Voices button to download voices from myTobiiDynavox.com and install them.

When you select the Download & Manage Voices button, the Manage Voices menu will open.

Figure 6.29 Manage Voices Menu

Select a voice, then select the Install button to download and install the voice, or select the trashcan icon
to delete it.

Certain voices are designated as Read Only and cannot be deleted.
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6.2.3 Manage Pronunciations

The speaking voice may not always say words correctly - especially in the case of proper names and some foreign-derived
words. You can save alternate text or phonetic spellings of words to correct any pronunciation problems.

1. Select the Manage Pronunciations button on the Voice Settings menu. The Pronunciation Exceptions menu will
open.

2. Select the Manage button at the top right corner of the screen.
3. Select either the New Text Exception or the New Phoneme Exception button.
4. A dialog will open. Use the onscreen keyboard to type the proper spelling of the word, and then type the phonetic spell-

ing (or select the appropriate phonemes). Then select Save (or OK for phonemes) to close the dialog and save the pro-
nunciation exception.

Figure 6.30 Text Exception Dialog

6.2.4 Highlighting

You can choose whether or not you want the text in the message window to be highlighted when it is spoken. You can then se-
lect a highlight style and color.

To enable highlighting, select the checkbox next to Highlighting.

Figure 6.31 Highlighting Enabled
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Then select the Configure button to open the Highlighting menu.

Figure 6.32 Highlighting Menu

1. Use the Highlight Type drop-down list to choose what you want highlighted when the message window is selected

● Highlight Word - Each word will be highlighted as it is spoken.
● Highlight Word and Symbol - Each word and its corresponding symbol will be highlighted as the word is

spoken.
● Highlight Sentence - Each sentence will be highlighted as it is spoken.
● Highlight Sentence and Word - Each sentence will be highlighted (with Highlight Style 2) as it is spoken. Each

word will be highlighted (with Highlight Style 1) as it is spoken.

2. Use the Style 1 and Style 2 drop-down lists to choose the style of highlighting when the message window text when is
spoken.

Highlight Style 2 will only apply when you select the Highlight Sentence and Word option in the High-
light Type drop-down list.

Select from the following highlight styles:

● Fill Color - The word (or sentence) will be highlighted with the color you choose.
● Outline Color - The word (or sentence) will be outlined with the color you choose.
● Invert - The text and the text background color will switch. (For example, if the text is black, and the background is

white, the text will appear white and the text background, black.)
● Text Color - The text in the word or sentence will change to the selected color as it is spoken.

3. Choose a color for Highlight Styles 1 and 2.
Select the color button to the far right of Style 1 drop-down list (circled in Figure 6.32 Highlighting Menu, page 41). The
Choose Color dialog will open.

Figure 6.33 Choose Color Dialog

a. Select a color for the highlight.

You can choose a color from the Standard Colors drop-down list on the Choose Color dialog, or you
can use the Red, Green, and Blue and Opacity slider bars to create a custom color.

b. Select OK to close the Choose Color dialog and save your color choice.
c. Select the Color button to the right of the Style 2 drop-down list. Repeat steps a and b above to choose a color for

Highlight Style 2.
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6.2.5 Voice Boost

Clear the checkbox next to Voice Boost to disable the volume boosting feature.

If you notice the speech is "breaking up," disable the Voice Boost feature.

6.2.6 Volume

Use the Volume slider to set the volume from 0 to 100.

6.2.7 Rate

Use the Rate slider to adjust the speaking rate. Dragging the slider from left to right increases the speech rate.

6.2.8 Voice Preview

Select the Speak button to the right of Voice Preview to hear how the voice and rate of speech you have selected sounds.
You can change the voice and increase or decrease the rate of speech until you are happy with the voice and the speaking rate
you have chosen.

6.3 Interface Settings
Use the Interface Settings menu to adjust or define how certain objects are presented onscreen. The Interface Settings menu
is organized by tab, with each tab pane presenting a different group of controls and options.

Interface settings options may vary, depending on the pageset you are using. The NavBar pageset is used as an ex-
ample here.

Open the Settings menu. (See 5.1 Open the Settings Menu, page 22.) Then select Interface. The Interface Settings menu
will open to the default General Settings tab.

6.3.1 General Settings

Figure 6.34 Interface Settings - General Settings
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Select a Home Page and Keyboard page. Password-protect page editing and access to the Settings menu, and choose a lan-
guage, choose a window style and language.

On Android devices, you also have the option of locking the Android Toolbar.

When you have finished customizing your general settings, select the green Done button at the top right corner of the screen.

6.3.2 Toolbar and Navigation Bar Settings

Figure 6.35 Interface Settings - Toolbar and NavBar Settings

Select a location for your Toolbar and Navigation bar, and enable or disable (hide) the Toolbar.

6.3.3 Message Window Settings

Figure 6.36 Interface Settings - Message Window Settings

Customize the settings for your message window: use symbols, use large symbols, auto-capitalize words at the beginning of a
sentence, auto-space between words, use a thicker, more visible cursor, clear the message window after speech, speak as
words are entered into the message window, show misspellings, and select a custom slot popup layout.

Select the Browse button to open the Page Browser and search for a popup to use for slots (in some pagesets).

When you have finished customizing your message window settings, select the green Done button at the top right corner of
the screen.
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6.3.4 Button Settings

Figure 6.37 Interface Settings - Button Settings

Track button usage.

The animation feature is not available at this time.

When you select Enabled and Display Usage, usage counts will appear on each button. (See Figure 6.38 Display Button Us-
age (Example) , page 44.) To reset the button usage counts back to zero, press the Clear Data button.

Figure 6.38 Display Button Usage (Example)

When you have finished customizing your button settings, select the green Done button at the top right corner of the screen.

6.3.5 Age & Ability Level Settings

Figure 6.39 Interface Settings - Age & Ability Level

Changes the content based on your selection of age and ability level.

When you have finished customizing your age and ability level settings, select the green Done button at the top right corner of
the screen.

6.4 Toolbar Editor
You can personalize the Toolbar - add a new button or folder, edit or delete buttons or folders, move them up or down the Tool-
bar, and hide items on the Toolbar.
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Toolbar settings options may vary, depending on the pageset you are using. The NavBar pageset is used as an exam-
ple here.

Open the Settings menu. (See 5.1 Open the Settings Menu, page 22.) Then select Toolbar Editor. This menu shows all of
the buttons and folders - both hidden and visible - in your Toolbar.

Figure 6.40 Configure Toolbar Settings

Select Manage at the top right corner of the screen to edit the Toolbar. A button bar will open at the top of the Configure
Toolbar menu that will let you edit your Toolbar.

Figure 6.41 Button Bar on Configure Toolbar Menu

● Select New Button or New Folder to open a dialog and add a new button or folder

Figure 6.42 New Button
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Figure 6.43 New Folder

● To edit a folder or button - select it (a blue check mark will appear on the object), and then select Edit. The Toolbar
Button or Toolbar Folder dialog will open to allow you to edit the object.

Figure 6.44 Edit Toolbar Item

If you select the Open Page command, you must also designate the page that will open when the button is
selected.

– To move a Toolbar button or folder, select it, then select Move Up or Move Down.
– To hide a Toolbar button or folder select it, then select Hide.
– To show a hidden item, select Show.

Selecting a hidden item in the list will change the Hide button to Show on the button bar.

– To delete an item, select it, then select the trashcan icon.

When you have finished customizing your Toolbar settings, select the green Done button at the top right corner of the screen.
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7 Rate Enhancement
The Compass software offers rate enhancement features that can help the user communicate more quickly and efficiently.

Both abbreviation expansions and word prediction allow the user to enter only a few letters in the message window using the
onscreen keyboard, and the software will anticipate word choices.

Open the Settings menu. (See 5.1 Open the Settings Menu, page 22.) Then select Rate Enhancement.

Figure 7.1 Rate Enhancement Settings

7.1 Abbreviation Expansions
You can compile your own list of abbreviations for frequently used words (for example, names of friends, family, places, pets,
etc.).

Make sure that the Auto Expand Abbreviations check box in the Auto Expand Abbreviations section of the
Rate Enhancement menu is selected to use the abbreviations you create.

7.1.1 To Add an Abbreviation Expansion

1. Select the Manage button in the Auto Expand Abbreviations section, and the Abbreviation Expansions menu will
open.

Figure 7.2 Abbreviation Expansions Menu

2. Select the Manage button. A button bar will open.
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3. Select the New button, and the Edit Abbreviation Expansion dialog will open.

Figure 7.3 New Abbreviation Expansion

4. In the Abbreviation text box, use the system keyboard to type a few letters that represent the word you are abbreviat-
ing. (For example, enter "fl" for "Fluffy."

5. Type the entire word in the Expansion text box.
6. Select Save.
7. Select Done in the upper right corner of the screen.

To expand the abbreviation, just type it into the message window. It will automatically expand after entering a space.

Please note that the abbreviation must be entered into the message window exactly as it appeared when you created
it. For example, if the abbreviation you created is "als" (without spaces between the letters), entering "a l s" into the
message window will not expand.

7.1.2 Edit an Abbreviation Expansion:

1. Select the Manage button in the Auto Expand Abbreviations section, and the Abbreviation Expansions menu will
open.

Figure 7.4 Abbreviation Expansions Menu

2. Select the Manage button. A button bar will open.
3. Select the abbreviation exception you want to edit.
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4. Select the Edit button, and the Edit Abbreviation Expansion dialog will open.

Figure 7.5 Edit Abbreviation Expansion

5. Make your changes in the Expansion text box.
6. Select Save.
7. Select Done in the upper right corner of the screen.

7.2 Word Prediction
Word prediction can be used on any page that includes a message window and predictor buttons. As the user composes a
message, the prediction feature anticipates word choices and displays vocabulary options for quick selection - these vocabulary
options are displayed on the predictor buttons.

You can activate and deactivate prediction features using the Rate Enhancement menu.

Figure 7.6 Word Prediction Settings on Rate Enhancement Menu

1. Select the Settings button in the Prediction section of the Rate Enhancement menu, and the Prediction Settings
menu will open.
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Make sure the Enabled check box is selected. Word prediction is enabled by default. Clear the check box to
disable automatic word prediction.

Figure 7.7 Prediction Settings

2. Select or clear the following check boxes on the Rate Enhancement menu to enable/disable the following word predic-
tion features:

● Show Symbols with Predictions - This feature is also enabled by default. Clear the check box to hide symbols.
● Predict Words only Once - When the Predict Words only Once check box is selected, the user has only one

chance to select a word in a predictor button. If a word is not selected, that word will not be predicted again until
after the user completes the word he or she is entering - by adding ending punctuation or a space.

● Context Predictions Off - When this feature is enabled, the Compass software will not anticipate word selections
based on the grammatical structure or word sequence of the sentence being entered.

● Next Letter Prediction - On a keyboard, when this feature is enabled, any letters that would not be a feasible op-
tion based on the letter or sequence of letters entered will not be predicted.

● Don’t Predict Words on Buttons - When this feature is enabled, a word that already appears on a button on the
current page will not be predicted.

● Enable Prediction Learning - Prediction learning enables the Compass software to learn frequently used words
and add these words as prediction options.

7.3 Message History

Toolbar message history functionality is currently available in the Navigator and All Access pagesets only.

Message History stores anything that has been spoken or entered into the message window. The message history can be used
to repeat a message, to save the message to a topic or to another page, or to compose an email.

You can choose the amount of time (one week to forever) that messages will be stored in the message history.

Message history can be searched by keyword. Single items can be deleted from message history or the entire history can be
cleared.

Message history settings are selected through the Rate Enhancement menu.

Access your message history through the Message History topic on the Toolbar of your Navigator, All Access, or Core First
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pageset. Message History can be found on the Dashboard page of the Navbar, Stroke & Brain Injury Persona, and Master page
pagesets. For the Text-Based Pageset, Message History is found on the main page.

Figure 7.8 Message History Settings on Rate Enhancement Menu

7.3.1 Message History Settings

1. Select Settings button in the Message History section of the Rate Enhancement menu. The Message History
Settings menu will open.

Figure 7.9 Message History Settings

2. To use message history in phrase prediction, select the Enabled check box next to Use History in Phrase
Prediction.

3. Select the duration of time for which you want to save message history - from seven days to forever.
4. To clear your message history, select Clear. A confirmation dialog will open. Select Yes on the dialog to clear your mes-

sage history.
5. Select OK to save your message window settings.

7.3.2 Access Message History

1. Select Message History on your Toolbar (All Access and Navigator Page Sets only).

You can search message history for a specific message. The Search button is circled in Figure 6.38 Display
Button Usage (Example) , page 44.

This feature is pre-programmed into the All Access and Navigator Page Sets. In other pagesets, you must pro-
gram a button with Actions to access the Message History feature.
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2. Select the Send To icon (circled in Figure 7.10 Message History Selected in All Access Pageset, page 52) to the right
of the message.

Figure 7.10 Message History Selected in All Access Pageset

3. Select the destination to which you want the message sent. (Or select the trash icon to delete the message.)
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8 Vocabulary
Only the Navbar Pageset, Stroke & Brain Injury Persona, All Access, and Navigator pagesets store word lists in Vo-
cabulary. The Core First and Master Page pagesets only store slot filler lists (not word lists) in Vocabulary.

Most vocabulary items are stored in folders. You can edit, copy, delete, change the order of appearance onscreen, and add new
vocabulary items using the Vocabulary menu.

Open the Settings menu. (See 5.1 Open the Settings Menu, page 22.) Then select Vocabulary.

Figure 8.1 Vocabulary Menu

Select the Word Lists, My Phrases, or Topics folder.

Figure 8.2 Vocabulary Menu - Word Lists (Example)

Navigate through the folders (use the arrow button at the upper left of the screen - to move up through the layers of folders.) Se-
lect a folder to open it.

When you find the folder or item you wish to edit, select Manage at the top right corner of the screen.
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If you are adding a new folder or item, navigate to the level at which you want to add the folder or item, then select
Manage.

Figure 8.3 Edit Vocabulary Menu (Example)

When you select the Manage button, a button bar will open.

Figure 8.4 Button Bar on Vocabulary Screen

Select the item you want to modify. Then select the applicable button on the button bar.

● Edit - The Vocabulary Properties panel will open to the default Edit tab.

Figure 8.5 Vocabulary Properties Panel

Enter a new label, browse for a symbol, and/or add or change the message.

The Message field will not be present when you are editing a folder.

Select the Properties tab in the Vocabulary Properties panel to change the age and ability level for the item you are
editing.

● Copy To - The Select a Folder screen will open. Navigate through the levels to find the folder you would like to copy
to.

54 8 Vocabulary Tobii Dynavox Compass User’s manual v.2.3 - en-US



● Order - Use the First, left arrow, right arrow, or Last buttons at the top of the screen to reorder the selected item.
● New Folder - Create a new folder. Use the onscreen keyboard to enter a label and symbol for the new folder. Select

the Properties tab in the Vocabulary Properties panel to define the age and ability level for the new folder.
● New Item - Create a new item. Use the onscreen keyboard to enter a label, symbol, and message for the new item. Se-

lect the Properties tab in the Vocabulary Properties panel to define the age and ability level for the new item.

● Delete item - Select the trashcan icon . To delete the selected item.
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9 Ability Levels
Some pagesets offer the Ability Levels feature. If your pageset supports Levels, a Levels button will be present in the Settings
menu.

One of the most exciting features of the Compass software is the ease of moving up through ability levels as your user’s com-
munication skills progress.

The Levels menu enables you to quickly and easily choose among ability levels to get the most appropriate tools and content
and button size. The Levels menu also provides access to overview videos and allows you to configure your topics, keyboard
layouts, Quickfires, etc.

Open the Settings menu. (See 5.1 Open the Settings Menu, page 22.) Then select Levels.

Figure 9.1 Levels Settings (NavBar Pageset)

1. Select an appropriate level from the Ability Level tabs at the top of the screen.

Select the Intro to Levels button at the top left of the screen and watch the video(es) for more information
on levels.

2. Customize your settings Under Configure Tools.
Simply select a tool, and a dialog will open. The dialogs for Quickfires and Topics for the NavBar pageset (Level 3) are
illustrated in Figure 9.2 Quickfire Settings on Levels Page (NavBar Pageset), page 56 and Figure 9.3 Topic Settings on
Levels Page (NavBar Pageset), page 57.

Figure 9.2 Quickfire Settings on Levels Page (NavBar Pageset)
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Figure 9.3 Topic Settings on Levels Page (NavBar Pageset)

The Levels menu gives you another opportunity to configure your Toolbar.

3. As you make changes on each dialog, select the green Save button to close the dialog and save your changes.
4. When you are finished, select the green Done button at the top right corner of the screen.
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10 Page Browser
The Page Browser is the quickest way to find a page to open or edit. You can search for a page by name, or look through the
folders and see preview images of pages before opening them. You can also create a new page using the Page Browser.

Open the Settings menu. (See 5.1 Open the Settings Menu, page 22.) Then select Page Browser.

Figure 10.1 Page Browser (Example - NavBar Pageset)

The icons at the top right of the screen (circled in Figure 10.1 Page Browser (Example - NavBar Pageset), page 58) enable you
to display the pages and folders as a grid (default) or list.

Use the arrow button at the upper left of the screen (circled in Figure 10.1 Page Browser (Example - NavBar Pageset), page
58) to move up through the layers of folders. Select a folder to open it and display the pages inside. Select a page, and a large
thumbnail of the page will open.

Figure 10.2 Selected Page in Page Browser

Simply select Open to open the selected page or Editor to open the Editing Toolbar and edit the page. (See 12 The Compass
Editor, page 65.)
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11 Modifying an Object on a Page
You can easily customize your pages - modify any object - including the page itself - to change its properties - its symbol, label,
audio cue, layout, actions performed when it is selected, etc.

1. Select the Modify button on your screen

● For all pagesets except All Access and Navigator, the Modify button is located in the top right corner of your screen.
(See Figure 11.1 Modify Button - All Pagesets Except All Access and Navigator, page 59.)

Figure 11.1 Modify Button - All Pagesets Except All Access and Navigator

● For the All Access and Navigator pagesets, the Modify button is located in the bottom right corner of your screen.
(See Figure 11.2 Modify Button - All Access and Navigator Pagesets, page 59.)

Figure 11.2 Modify Button - All Access and Navigator Pagesets

If the Toolbar is disabled, when you select the Modify button, a dialog will open with two options: Modify or
Settings. Select Modify.

You will enter Modify Mode (A red bar will appear at the bottom of the screen with the message, "Modify Mode. Select
an object to modify").

Figure 11.3 Modify Mode

2. Select the object on the page to be modified. (Or select the page itself.)

The object’s Properties Panel will open.

The instructions that follow are specific to modifying a button, as that is the object on the page that is most often modified, but
all page objects are modified in much the same manner - the Properties panel for each object will differ, however, depending on
the object’s properties.
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11.1 Modifying a Button

Figure 11.4 Button Properties Panel - Content Tab Open

The Button Properties panel contains six tabs:

11.1.1 Content Tab

On the Content tab, you can assign a label, a message, a symbol, and apply actions that will execute when that button is
selected.

1. Label
The label will appear on the face of the button.

a. Select the Label field or the keyboard icon to the right of the Label field.
b. Type the new label using the onscreen keyboard.
c. Select Done on the onscreen keyboard.

2. Message
The message will not appear on the face of the button. Messages can be used for a more lengthy or more complex line
of text. For example, if the label of the button is "Address," the message could be the user's actual address. When using
messages, be sure to assign corresponding actions. It can be used with actions such as Insert Message or Speak Mes-
sage. (See 4. Actions below.)

a. Select the Message field
b. Select the Replace button.
c. Type the new message using the onscreen keyboard.
d. Select Done on the onscreen keyboard.

Selecting Reset will cause the button to reset the message to match the text in the Label field.

3. Symbol
Symbols help users associate concepts more quickly and easily.

To assign or change a symbol:

a. Select the blue Select... button next to the Symbol field. Symbols based on the label you entered will be suggested,
but you can search for different symbols using the search field at the top of the screen. Just select the Search field,
and use the onscreen keyboard to type what you're searching for.

b. Select a symbol. When a symbol is selected, a blue check mark will appear over the symbol. To choose a different
symbol, just select a new one. The first choice will automatically deselect.
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You can also select the Images tab to browse for a photo or drawing, or, if your device has an integrated
camera, take a photo with the camera.

Figure 11.5 Select a Symbol

c. Select the green Select button at the top right corner of the screen.

4. Actions
Actions make the button do something. Whether you want to speak a label directly from a button or compose text in a
message window, you'll need to assign actions to your button.

To assign actions:

a. Select the Actions field. The Script Editor will open.
b. From the drop-down list in the left panel of the Script Editor, select the type of actions you're looking for. For exam-

ple, if you're assigning actions to a button, select Buttons from the list. This will show you a list of popular button
actions.

Figure 11.6 Script Editor - Drop-Down List

c. A list of available actions will display in the left panel. For example, if you selected Buttons, button actions will be
displayed with a brief description of each action.

Select the pencil icon next to an action to view variations of the action.
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d. Select the action to assign to your button. As you make your selections, actions assigned to your button will appear
in a list in the right panel.

To delete actions, make selections from the list of assigned actions, and select the red trashcan icon at the
top of the screen.

e. After assigning actions, select the green Done button at the top right corner of the screen.

11.1.2 Font Tab

Font choices are available for all text, including button labels. Select the Font tab to choose font types, styles, sizes, and colors.

Figure 11.7 Font Tab

11.1.3 Layout Tab

The Layout tab enables you to change the button type and layout. If you wish to change the button type, use the Button Type
drop-down list to select a new button type:

Figure 11.8 Layout Tab

11.1.3.1 Button Type

● Standard - Buttons most often contain a label, a symbol, and have assigned actions.
● Word Predictor - A Word Predictor button anticipates the next logical word choice and displays various options for

quick selection. Typically used on keyboard and spelling pages, these buttons can greatly enhance the rate at which the
user communicates.

● Group - Buttons contain multiple, smaller buttons. Using group buttons can often help those who use the scanning ac-
cess method easily make faster choices.

● Phrase Predictor - Similar to Word Prediction, Phrase Predictor buttons anticipate logical phrases.
● Char Predictor - Again, similar to Word Prediction, Character Predictor buttons anticipate the next logical letter based

on the letter or sequence of letters entered.

In addition, various layout options (placement of symbol and label) are available to accommodate the user's preferences and
needs. Select the Symbol Layout button to choose a layout for the button.
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11.1.4 Style Tab

Many style choices are available, including different shapes, fill colors, border color and border width and style, gradient, and
gradient color.

Swipe or scroll down the Style tab to see all the style options.

Figure 11.9 Style Tab

11.1.5 Access Tab

Figure 11.10 Access Tab

For auditory scanning users, fields for audio cue and row/column cue are provided. The row/column cue is used if the button is
the first button in the row or column.

To enter an audio cue:

1. Select Replace.
2. Type the new audio cue using the onscreen keyboard.
3. Select Done on the onscreen keyboard.

To have the software skip the button when it is scanning, clear the Touch Only check box.
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11.1.6 Misc Tab

Figure 11.11 Misc Tab

To hide the button, select the check box next to Hidden.
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12 The Compass Editor
The Compass Editor allows you to edit a page to your own specifications or to create an entirely new page. (See 13 Creating a
Page, page 73).

If you just want to modify an object on a page, for example, to change the symbol or action on a button, or to change
an object’s layout or style, see 11 Modifying an Object on a Page, page 59.

Select the Editor button on the Settings menu. (See 5.1 Open the Settings Menu, page 22). The Editing Toolbar will appear
at the top of the page.

The Editing Toolbar will also open automatically when you create a new page using the Page Browser or Page
Creator.

The Editing Toolbar contains all of the tools that you will need for creating and editing pages.

Figure 12.1 Editing Toolbar

12.1 File

Figure 12.2 File

New Create a new page.

New From Template Create a new page from a template or "like" an existing page.

Save Save all the changes you have made to the page that is currently open

Open Opens the Select Page menu to open a new page to edit. (Opening a new page will close the
currently open page.)

Revert Cancel all the changes you have made to the currently open page since you last saved it.

Page Size Select a page size (or create a custom page size) that anticipates the positions of the Navbar
and Toolbar (Left, Right, Top, Bottom, or Off).

Macros Opens the Macro Editor.

Preferences Change editor preferences
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12.2 Edit

Figure 12.3 Edit

The Edit options will vary, depending on the selected object(s) on the page. For example, if a tab control is selected, there will
be an option for adding a new tab; if a standard button is selected, there will be fill options. (The options shown in the iFigure
12.3 Edit, page 66 are for a group button.)

Undo Undo the last change you made. (The software allows multiple levels of undo and redo.)

Redo Redo the last change you made. (The software allows multiple levels of undo and redo.)

Delete Permanently remove the selected object from the page.

Duplicate Copy the selected object and place the copy immediately next to the selected object.

Cut Remove the selected object(s) from the page and save to the clipboard so the object(s) can be
pasted back onto the page or onto another page.

Copy Make a duplicate of the selected object(s) and save to the clipboard so the duplicate can be
pasted elsewhere on the page or onto another page.

Paste Paste an object that has been cut or copied.

Select Parent Change the selection to contain the "parent" object of the object that was originally selected.
For example, if a button within a group box is selected, the "parent" of the button would be the
group box.

Select Contents Select all content (including label, symbol, and all objects in a group button or group box) in
the selected object.

Clear Contents Remove all content (including label, symbol, audio cue, and all objects in a group button or
group box) from the selected object.

12.3 Select

Figure 12.4 Select

Select Select a single object on the page (or the page itself).

Multi Select Select multiple objects on the page. (This tool replicates holding down the Ctrl key on a key-
board while clicking on multiple objects with a mouse.)

Spray Spray out copies of a selected object to make a rectangular grid.

Scan Order Set the order in which the objects on the page will scan.
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Lock "Lock" an object so that it will not be editable. Selecting the Lock tool will place lock icons on
each object on the page (including the page itself). Select each object that you want to lock.

Its lock icon will change from green to red, indicating that it is locked. (To unlock the ob-
ject, select the Lock tool again and then select the object you want to unlock.)

Measure Gives the measurements of the selected object or area.

12.4 Buttons

Figure 12.5 Buttons

Standard Place a "standard" (rectangular) button.

Group Place a group button.

(A group button is a button into which you can place other objects [a "multi-object" button]).

Word Predictor Place a word predictor button.

(A word predictor button anticipates the user’s word choices as a message is composed in the
message window.)

Phrase Predictor Place a phrase predictor button.

(A phrase predictor button works on the same principle as a word predictor button but will pre-
dict a phrase.)

Char Predictor Place a character predictor button.

(A character predictor button works on the same principle as a word predictor button but will
predict the next character based on the letter or sequence of letters the user has chosen.)

(Rectangular) Hotspot Place a rectangular hotspot

(Hot spots are usually placed over portions of images or visual scenes on a page. Then the hot
spot is programmed so that when it is selected, an action will be performed.)

(Invisible) Hotspot Place an invisible hotspot.

(An invisible hot spot can have actions assigned to it, but it has no borders, color, symbol, or
other visible characteristics.)

Freeform Button Draw a button of any shape you want.

(Touch the screen of your device and move your finger [or mouse if using the editing software]
around the page until the button is the size and shape you want.)

To place a button on the page, simply select the appropriate button tool and then select a location on the page.

To draw out a button on the page, touch the screen of your device and use your finger (or mouse if using the editing software)
to draw out the button.

To resize the button, select it, and then move your finger (or mouse) over the edge or corner of the button until a double arrow
appears. Drag until the button is the size and shape you want.
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After you have drawn the button, select it, then select the Properties button in the top left corner of the button. (See Figure 12.6
Properties Button on Button, page 68.)

Figure 12.6 Properties Button on Button

The Button Properties panel will open. Use the Button Properties panel to modify a button - assign a label, message, and sym-
bol to the button, change its appearance, and apply actions. See 11 Modifying an Object on a Page, page 59.

12.5 Label (Non-button Objects)

Figure 12.7 Label (Non-button Objects)

Label Place text anywhere on the page.

Symbol Place a symbol anywhere on the page.

After you have placed the symbol - a bounding box (or "placeholder") will appear on the page -
select the Properties button in the top left corner of the bounding box. The Symbol Properties
panel will open and enable you to select the symbol you want.

Message Window Place a message window on the page.

Tab Control Place a tab control.

To add additional tabs, select the tab control. Then select Edit > New Tab.

Group Box Place a group box on the page.

(A group box acts as a "container" for groups of buttons, check boxes, radio buttons, or other
objects.)

Vocabulary Grid Place a vocabulary grid on the page.

After you have placed the vocabulary grid, select the Properties button in the top left corner of
the grid to browse for and select a vocabulary source.

Video Place a video object on the page.

After you have placed the video object, select the Properties button in the top left corner of the
object to select a video.

Line Place a line on the page.

To draw out a line on the page, touch the screen and use your finger [or mouse if using the edit-
ing software] to draw out the line.

Text Box Place a text box on the page.

Text boxes are similar to message windows in that they display text messages entered by key-
board input. They differ from message windows, however, in that text boxes are used for short
text entries - only one word or line of text.
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Check Box Place a check box on the page.

By default, each check box includes a frame in which a symbol will appear when it is selected.

Check boxes work independently of one another and are useful when multiple selections are
allowed.

Radio Button Place a radio button on the page.

By default, each radio button includes a frame in which a symbol will appear when it is selected.

In each group of radio buttons, only one selection is allowed.

To place an object on the page, simply select the appropriate tool and then select a location on the page.

To draw out the object, touch the screen of your device and use your finger (or mouse) to draw it out.

To resize the object, select it, and then move your finger (or mouse) over the edge or corner of the object until a double arrow
appears. Drag until the object is the size and shape you want.

After you have drawn the object select it, then select the Properties button in the top left corner. (See Figure 12.8 Properties
Button on Tab Control, page 69.)

Figure 12.8 Properties Button on Tab Control

The object’s Properties panel will open. Use the Properties panel to modify the object. See 11 Modifying an Object on a Page,
page 59.

12.6 Layout

Figure 12.9 Layout

The Layout options will vary, depending on the selected object(s) on the page. (The options shown in Figure 12.9
Layout, page 69 are for two buttons - with labels - selected.)
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12.6.1 Arrange

Figure 12.10 Arrange

Arrange objects on the page. (Objects on a page are layered and can overlap.)

● Bring Forward - Move the selected object up one layer.
● Bring to Front - Reposition the selected object as the top item on the page.
● Send Backward - Move the selected object down one layer.
● Send to Back - Reposition the selected object as the bottom item on the page.

12.6.2 Align

Figure 12.11 Align

Adjust the relative positions of multiple selected objects on the page by aligning the selected objects on the page based on the
position of the primary object.

If you have multiple objects selected on a page, the "primary" object is the object displaying the Properties button.
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12.6.3 Center

Figure 12.12 Center

Center the selected objects on the page horizontally, vertically, or both horizontally and vertically.

12.6.4 Size

Figure 12.13 Size

Resize all of the selected objects. The resulting size is based upon the primary object - the object displaying the Properties but-
ton. (That is, all selected objects will be resized to match the size of the primary object.)

● SameWidth - Resize the selected objects to the same width.
● Same Height - Resize the selected objects to the same height.
● Same Size - Resize the selected objects to the same size.
● Fill in Parent - Resize the selected objects to the size of their parent object while retaining their shape.
● Gridify - Resize the selected objects to fit within the background gridlines.
● Gridify in Parent - Resize and reshape the selected objects to fill their parent object.

If only one object on a page is selected, the options available in the Size menu are Full Width, Full Height, and Full
Size. (The selected object will fill the width of the page, the height of the page, or fill the entire page.)

12.6.5 Alphabetize

Figure 12.14 Alphabetize

Adjust the relative positions of selected objects on a page alphabetically - based on their labels.
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12.6.6 Swap

Figure 12.15 Swap

Exchange the positions of two selected objects. (The contents of the objects will remain with their original objects.)

This option is only available if two objects on the page are selected.

12.6.7 Spacing

Figure 12.16 Spacing

Adjust the horizontal and vertical spacing of three or more selected objects on the page.

(This menu option is only available if three or more objects on the page are selected.)

12.7 Exit

Figure 12.17 Exit

Closes the Editing Toolbar.

(A confirmation dialog will appear asking if you want to save changes to the page.)
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13 Creating a Page
Create an new page - either from a template (including a blank template), or based on the layout of an existing page. You can
customize your new pages with your own content - vocabulary, symbols, media files, etc.

You can also create a new page directly from the Compass Editor. (See 12 The Compass Editor, page 65.)

Open the Settings menu. (See 5.1 Open the Settings Menu, page 22.) Then select Page Creator.

Figure 13.1 Page Creator

The icons at the top right of the screen (circled in Figure 13.1 Page Creator, page 73) enable you to display the pages and fold-
ers as a grid (default) or list.

Select from a number of templates (blank or by activity type or instructional area) or select the Like Page tab to create a new
page using the layout of an existing page. You can also use the Search text field to find a page you would like to use as a
template.

Use the arrow button at the upper left of the screen (circled in Figure 13.1 Page Creator, page 73) to move up through the
layers of folders. Select a folder to open it and display the pages inside. Select a page, and then select Create at the top right
corner of the screen. A dialog will open - name the page and browse for a location for it.

The Editing Toolbar will open. Use the Editing Toolbar to place new objects on the page, resize, duplicate, delete, rearrange ob-

jects, etc. (See 12 The Compass Editor, page 65.) Select the Properties button at the upper left corner of a selected ob-
ject to open its Properties panel and customize the object - symbol, label, message, layout, actions performed when it is
selected, color, etc. (See 11 Modifying an Object on a Page, page 59.)
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14 The Remotes Manager
On select devices the Compass software has the ability to send and receive infrared (IR) signals, so the device can function as
a remote control for electronic equipment such as stereos, cable boxes, televisions, DVD players, and IR-enabled telephones.

On your device:

1. Open the Settings menu. (See 5.1 Open the Settings Menu, page 22.) Then select Remotes.

Figure 14.1 Remotes button in the Settings Menu

2. In the Remotes Manager, select Manage.
The Remotes button bar will open.

3. Select New.
The Edit Remote dialog will open.

Figure 14.2 Remotes Button Bar

4. Select the Remote Name text field and use the onscreen keyboard to enter a name for your remote.

Figure 14.3 Edit Remote Dialog

5. Select Edit Commands on the Edit Remote dialog.
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6. On the Commands page, select Manage. The Commands button bar will open.
7. Select New.

The New Command dialog will open.

Figure 14.4 Commands Button Bar

8. In the New Command dialog, select the Command Name text field.
Use the onscreen keyboard to enter the name of the command you would like to add.

Figure 14.5 New Command dialog

9. Select Learned, then select OK.
The Record Command dialog will open.

10. Read the instructions on the Record Command dialog and position your device and remote accordingly.
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When ready, select Record.

Figure 14.6 Record Command Dialog

11. Follow the onscreen prompts to record the command.

Figure 14.7 Push Button On Remote Control

12. The Status message on the Record Command dialog will indicate if your command recorded successfully.

a. If it was successful, press OK.
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b. If it was not successful, press Re-Record and repeat step 12.

Figure 14.8 Command recorded successfully.

13. The command you created should appear in the list on the Commands dialog. Select the name of the command you just
created.
The Learned Command dialog will open.

14. Point your device at the electronic equipment you wish to control and select Test.

Figure 14.9 Test Command

15. If your test is successful, select OK.
The Learned Command test dialog will close.

16. Repeat the steps for each additional command you would like to add to the remote.
17. When you have finished adding commands to the remote, select Done.

You can now control your new remote from the remote control page in your pageset.
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15 AccessIT
Compass supports the Tobii Dynavox AccessIT 3, a USB Bluetooth device used to send key strokes, mouse movements, and
mouse clicks to a standard Windows 10 computer from a device running Tobii Dynavox Compass software. To learn more about
Tobii Dynavox AccessIT 3 visit http://www.tobiidynavox.com/AccessIT

AccessIT page packages are available at https://www.mytobiidynavox.com/PagesetCentral

Henceforth, this document will refer to the computer receiving commands as “the PC” and the device from which
commands will be sent as “the speech device.”

The AccessIT 3 uses Bluetooth® wireless technology. The PC (with connected AccessIT 3) and the speech device
must be within approximately 10 meters (32 feet) to establish and maintain Bluetooth pairing while the AccessIT 3 is
in use.

Both the speech device and PC must be powered on and unlocked before beginning the steps below.

15.1 Set up AccessIT
Connect the AccessIT 3

1. (On the PC) Insert the AccessIT 3 into a USB port.

AccessIT 3 requires USB 2.0 or higher.

Enable Bluetooth —Windows Speech Devices

1. (On the speech device) Select the Windows Start menu, then choose Settings.
2. Select Devices.
3. Select Bluetooth.
4. Move the Bluetooth toggle to the ON position.

15.2 AccessIT Actions
The AccessIT actions are designed to be used in combination. Common PC operations such as click and drag will require more
than one action. Individual actions are described below.

If an AccessIT 3 device is not connected when a button containing an AccessIT action is selected, the (accessible)
AccessIT device picker will open automatically.

AccessITConnect() Disconnect the current AccessIT 3 device (if any) and display the AccessIT device picker. This
action is useful for switching from one AccessIT 3 device to a different AccessIT 3 device. It is
not necessary to use this action to start all AccessIT sessions, as all of the AccessIT actions
automatically open the AccessIT device picker if an AccessIT 3 device is not currently
connected.

AccessITReset(value) Stop the specified command types that are currently being executed: keyboard keys, mouse
clicks, mouse movements, and/or text.

AccessITSendButton
(value)

Send the button Message to the AccessIT 3 device. If the button does not have a Message,
send the button Label.

AccessITSendKeyboard-
Key(value)

Send the specified keyboard key. Options: hold the key down and/or wait for a specified
length of time after sending the keyboard key (before performing the next action).

AccessITSendMessage-
Window()

Send the current Message Window text to the AccessIT 3 device. If the Message Window is
symbolated, the symbols are not sent.
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AccessITSendText
(value)

Send the specified plain text to the AccessIT 3 device.

AccessITSendMouse-
Click(value)

Send the specified click type. Options: wait for a specified length of time after sending the
click (before performing the next action).

AccessITSendMouse-
Move(value)

Send a mouse movement to the AccessIT 3 device. Mouse movements are made from the cur-
rent (when the action is executed) mouse position e.g. current mouse position = 0. Enter a val-
ue between –100 and 100 in the X and Y fields to define the direction and distance of mouse
movement. Negative numbers move the mouse left (X) and up (Y). Positive numbers move the
mouse right (X) and down (Y). Options: continuous movement (the mouse will continue to
move in the specified direction until another action stops/redirects it or it runs into the edge of
the screen) and/or wait for a specified length of time after sending the mouse movement (be-
fore performing the next action).

Some AccessIT 3 users may find it helpful to enable the Windows setting “Show location of pointer when I press the
CTRL key” on the PC. Use the AccessITSendKeyboardKey(value) action to send the CTRL keyboard key from Com-
pass and animated circles will temporarily appear around the mouse pointer on the PC to make it more visible. To ac-
cess this Windows mouse setting, go to Settings > Devices > Mouse > Additional Mouse Options > Pointer
Options tab on the PC.

15.3 PC Power Settings and AccessIT
Your PC can only receive AccessIT commands when it is powered on and awake. To ensure uninterrupted PC access, adjust
your PC energy settings to never put the computer (hard disk) to sleep when plugged in.

Your PC can still receive AccessIT commands if the screen (display) has gone into a power-saving mode. When an AccessIT
command (keyboard key, mouse movement, or mouse click) is sent from Snap it will “wake” the PC screen.

Windows power settings are found in Settings > System > Power & Sleep.
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16 Camera
If your Compass software is running on a device with an integrated camera, the camera module will be enabled.

Open the Settings menu. (See 5.1 Open the Settings Menu, page 22.) Then select Camera.

1 2 3

Figure 16.1 Camera

1 Opens your Media Library, and, if an image has been snapped, also saves that image.

2 Switches the camera from rear facing to front facing.

3 Select to snap a photograph. After an image has been snapped, the Snap Image button updates to
New Image. Selecting New Image again saves the current image to your Media Library and snaps another
image.
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17 Your Media Library
The Media Library is a viewer for all of your photos and videos. Videos and any photos that you take with your device will be dis-
played in folders under the Images and Videos tabs.

Open the Settings menu. (See 5.1 Open the Settings Menu, page 22.) Then select Media Library.

Figure 17.1 Media Library (Example - Images)

When you select a folder under the Images tab and then select a specific image, a full-screen photo viewer will open.

Figure 17.2 Image Viewer

Use the Previous and Next buttons at the top of the screen to scroll through all of the images in the folder.

Select the Videos tab to open your video library. Select a videos folder, and then select the video file you want to play. Then se-
lect Open on the Options dialog.
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18 Backing Up and Restoring
When you completed the Setup Wizard, you saved many settings for the pageset, vocabulary, media library, rate enhancement
information, selection method settings, etc. A backup file saves these customized settings, your edited pages, and data such as
vocabulary.

It is important that you back up regularly.

Open the Settings menu. (See 5.1 Open the Settings Menu, page 22.) Then select Backup/Restore.

Figure 18.1 Backup/Restore Settings

You can back up and restore your pageset either locally or to myTobiiDynavox.com.

A micro USB adapter may be needed to back up and restore locally on selected devices.

18.1 Back up to myTobiiDynavox.com
1. Select the Backup to myTobiiDynavox button.
2. If you are prompted, sign in to your account by entering your username and password.
3. Enter a name (and description [optional]) for your backup file in the text box. (It’s a good idea to include the date in the

file name.)
4. Select OK.

18.2 Back up Locally
You can back up to your local hard drive or to a USB drive.

1. Select the Backup Locally button.
2. On the screen that opens, select a destination directory (backups is the default backup folder). Use the arrow button at

the upper left of the screen to move up through the layers of directories. Select a directory in which to save your backup
file.

3. Select the green Select button in the top right corner of the screen.
4. Enter a name for your backup file in the text box. It’s a good idea to include the date in the file name.
5. Select OK.
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18.3 Restore from myTobiiDynavox.com
1. Select the Restore from myTobiiDynavox button.
2. If prompted, sign in to your account by entering your username and password.
3. The Select Backup File screen will open. Select the backup file you want to restore. If necessary, use the arrow button

at the upper left of the screen to move up through the layers of directories.Then select the green Select button in the top
right corner of the screen.

4. Select OK. A progress bar will appear.

Selecting this option will reset the device and overwrite all user data, settings, and content.

18.4 Restore Locally
1. Select the Restore Locally button. The Select Backup File screen will open, displaying all of the backup files in the

Backups folder.
2. Locate the file you want to restore. If necessary, use the arrow button at the upper left of the screen to move up through

the layers of directories. Select your backup file or locate the file on your USB drive.
3. Select the backup file you want to restore. Then select the green Select button in the top right corner of the screen.
4. Select OK. A progress bar will appear.

Selecting this option will reset the device and overwrite all user data, settings, and content.

18.5 New Pageset Wizard
Open the New Pageset Wizard to walk you through the steps to choose an appropriate pageset.

18.6 Manage Login
Sign out/sign in to your myTobiiDynavox account.
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Support for Your Tobii Dynavox Device

Get Help Online
See the product-specific Support page for your Tobii Dynavox device. It contains up-to-date information about issues and tips & tricks related to the product.Find our Support pages online at:
www.TobiiDynavox.com/support-training

Contact Your Solution Consultant or Reseller
For questions or problems with your product, contact your Tobii Dynavox solution consultant or authorized reseller for assistance. They are most familiar with your personal setup and can best
help you with tips and product training. For contact details, visit www.TobiiDynavox.com/contact

Copyright ©Tobii AB (publ). Not all products and services offered in each local market. Specifications are subject to change without prior notice. All trademarks are the property of their respective owners.

http://www.TobiiDynavox.com/support-training
http://www.TobiiDynavox.com/contact
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